Social, Emotional, and Academic Development Field Landscape Analysis: relational mapping
Landscape Analysis contents

- **Landscape Analysis narrative:** A summary of field capacity
- **Relational map of perspectives and frames:** Connections among frameworks and terminology
- **Relational map of field actors:** Connections among field actors identified through Landscape Analysis
Landscape Analysis Relational Mapping: background

Context
This Landscape Analysis was conducted April-July 2018 by The Boston Consulting Group in support of the National Commission, in partnership with Grantmakers for Thriving Youth. The analysis was organized around 141 implementation levers within which 300+ organizations engaged in work to support Social, Emotional, and Academic Development (SEAD) were identified. The relational mapping analysis complements a Landscape Analysis narrative, captured in a separate document.

Purpose
The relational mapping effort focused on mapping and analyzing organizations in the Landscape Analysis either primarily or partially focused on SEAD, in order to map and analyze their relationships with partners and funders inside and outside of the SEAD space.

Approach
The team identified 300+ organizations involved in SEAD work through its work on the companion Landscape Analysis narrative. Additional details on these organizations were gathered into a comprehensive database including categorizing their approach across the different implementation levers and reviewing publicly available information on their partners and funders. A network mapping tool, Touchgraph Navigator, was used to visualize the networks. This tool is available for download online and easy to use alongside the database.

1. Note public funding and local, state, and federal advocacy levers have been combined for the purpose of this analysis. Therefore there are only 13 segments of field actors shown.
The Landscape Analysis was overseen by the National Commission’s Change Agenda Work Group, whose members included:

- Jorge Benitez, Former CEO, Accenture North America (Work Group Chair)
- Linda Darling-Hammond, President and CEO, Learning Policy Institute; Charles E. Ducommun Professor of Education, Emerita, Stanford University (Commission Co-Chair)
- Joshua Garcia, Deputy Superintendent of the Tacoma Public Schools
- Jackie Jodl, Executive Director of the National Commission
- General Craig McKinley, Four-Star Air Force General (Ret.); Former President and CEO, National Defense Industrial Association
- Karen Pittman, President, CEO, and Co-Founder of The Forum for Youth Investment
- Jim Shelton, President of Education, Chan Zuckerberg Initiative
- Tim Shriver, Co-Founder and Chair, CASEL; Chairman, Special Olympics (Commission Co-Chair)
- Ross Wiener, Vice President, Aspen Institute; Executive Director, Aspen Institute’s Education and Society Program

Additional advising was provided by Itai Dinour (Program Officer, Education, The Einhorn Family Charitable Trust), Will Miller (President, The Wallace Foundation), Brooke Stafford-Brizard (Director, Chan Zuckerberg Initiative), and Kathleen Traphagen (Lead Facilitator, Grantmakers for Thriving Youth)
Executive Summary

The Landscape Analysis profiled 314 organizations with a direct or adjacent relationship to the social, emotional, and academic development (SEAD) space

- Organizations were identified through interviews, a review of actors associated with the Commission and online research, and are meant to represent a thorough (but not exhaustive) profiling of major actors in the SEAD space.

Relational maps were developed to explore and visualize the connections among these organizations in order to better understand various dimensions of the SEAD network.

- This analysis focused on a subset of 224 actors with either a primary or partial focus on SEAD.
- An extensive database was built to document descriptive details about these organizations including publicly-named partner and funder relationships.

Initial review of this relational mapping data highlights several findings that suggest opportunities for growing field collaboration going forward (see more detailed summary of findings on p12):

- Not surprisingly, philanthropic and convening orgs. are central to the map and key to bringing the network together.
- TA Providers and National / Regional associations are more peripheral, potentially due to the fact that they rely less on philanthropic funding, but also suggesting opportunities to integrate further into the network.
- The top 50 most frequently named funders include 10 corporate entities, suggesting an opportunity to build more alignment both with and within corporate philanthropy.

This is a "beta" version analysis and there are a number of opportunities to further enhance it in future versions:

- Expanding the number of organizations profiled to include a more comprehensive set of SEAD actors.
- Exploring opportunities to standardize (and possibly automate) the process for collecting data.
Contents

Approach

Landscape actors

Key findings

Considerations for future analysis
Using Landscape Analysis actors, several visualizations of relationships were created

**Defined landscape**
Conducted a Landscape Analysis of the field via:
- Review of related research reports and lit review
- Interviews
- Web search

...in order to assess the state of the field and identify key SEAD actors

Organizations included based on:
- Interviews or research
- Association with a Commissioner
- Part of partners collaborative
- Funder of the Commission, or funder that submitted data for funder analysis

**Categorized organizations**
Website review conducted for each SEAD actor identified:
- Types of work and focus of organization
- Publicly listed partners and funders

Categorized actors by primary implementation lever based on where actor was most featured in the Landscape Analysis narrative

Categorized actors by degree of SEAD focus based on:
- Interviews
- Initiatives featured on website
- Note: All members of partners collaborative assumed to be focused on SEAD

**Identified relationships**
Relationships between SEAD actors were identified based on partners and funders listed on website

For each organization, up to 20 partners and funder were captured - if more than 20 listed on website, collected 20 most related to the space / likely to appear elsewhere in the database

**Mapped landscape**
Used TouchGraph tool to produce three types of relational maps:
- Relationships across SEAD-focused actors
- Associations of individual SEAD-actors
- Trends across universe of listed partners and funders

Relational mapping visualizes and quantifies relationships with partners and funders

---

1. Database for relational mapping based on organizations included in Landscape Analysis narrative as of 8/1/18. Some organizations added in final revisions of Landscape Analysis narrative after was database locked were not included but flagged to add in the future.
2. Based on partners collaborative list as of 10/20/17
Backup | Detailed relational analysis methodology

**Defined landscape**

Landscape Analysis and database of organizations developed by reviewing several key research reports and conducting ~100 stakeholder interviews.

Through research and interviews, 14 implementation levers identified around which the Landscape Analysis was organized (see appendix for description of each lever).

The Landscape Analysis identified 314 organizations across the field, some explicitly focused on social, emotional, and academic development and others adjacent to the space with potential to be more involved in the future.

The list of organizations included in the database were identified based on,
- Interviews or research
- Association with a Commissioner
- Part of partners collaborative
- Funder of the Commission, or funder that submitted data for funder analysis

The list of organizations included in the database were identified based on,
- Interviews or research
- Association with a Commissioner
- Part of partners collaborative
- Funder of the Commission, or funder that submitted data for funder analysis

**Categorized organizations**

For each of the 314 organizations in the database, the website was reviewed for additional information on each organization including a description, mission, etc. All data is available in the accompanying Landscape Analysis Field Actor Database.

Organizations identified were then categorized across implementation levers, e.g. technical assistance, preservice training, etc.

Organizations were also categorized based on their focus on SEAD. Of the original 314 actors, 224 were primarily or partially focused on SEAD.

Categorization of actors was done using several sources of input, including:
- Interviews
- Initiatives featured on website
- Note: All members of partners collaborative assumed to be focused on SEAD at least partially

**Identified relationships**

Relationships between the organizations were identified based on publicly listed partners and funders on the organizations website -
- Collected names of organizations that were listed clearly on website, usually on tab labeled “Partners”, “Funders”, “Investors”, etc.
- Captured up to 20 partners and funder for each organization - if more than 20 listed, collected 20 most related to the space / most likely to appear elsewhere in the database
- It is possible that the organizations have partnerships not listed on the website or not apparent through the methodology followed
- Note: funders in the database were not researched as outlined but were captured to the extent to which they surfaced on other field actor websites (see more detail on approach to funder analysis below)

Separate funder analysis conducted with data on investments submitted by funders. For relational mapping exercise, funders show up in the map only to the extent to which they are listed by other actors

**Mapped landscape**

TouchGraph Navigator leveraged to build three types of relational maps:
- Relationships across SEAD-focused actors
- Associations of individual SEAD-actors
- Trends across universe of listed partners and funders

Additional detail on how to load and use the database to build the visualized map is included at the end of this document.

Please note:
- This methodology limits the map to organizations identified through our Landscape Analysis, which is not an exhaustive list of actors in the space.
- The website review limits the map to connections explicitly stated as partnerships / funding relationships online.
- Therefore, this analysis is a starting point to draw connections among the actors in the Landscape Analysis database, but is not a complete view of relationships across the field.

1. Database for relational mapping based on organizations included in Landscape Analysis narrative as of 8/11/18. Some organizations added in final revisions of Landscape Analysis narrative after was database locked were not included but flagged to add in the future.
2. Based on partners collaborative list as of 10/20/17.
Relational map can be used to observe trends across broader Landscape and for individual SEAD actors

1. Across network of SEAD actors in Landscape Analysis
   - Identifies which SEAD actors are most connected across the field

   Can highlight:
   - Degree of connectedness / specific relationships with other SEAD-focused actors
   - Total number of associations
   - Implementation lever

2. For individual SEAD actors in Landscape Analysis
   - Identifies relationships between specific SEAD actors in the landscape

   Can highlight:
   - Number of relationships within network
   - Distinctions between partner and funder ties
   - Implementation lever

3. Across partners & funders named by SEAD actors in Landscape Analysis
   - Identifies trends across listed partner and funder organizations in terms of organizations that appear most frequently

   Can highlight:
   - Most commonly occurring partner / funder organizations (including those that are not SEAD-focused)
Agenda

Approach

Landscape actors

Key findings

Considerations for future analysis
Through Landscape Analysis, profiled 224 SEAD-focused actors that identified 908 unique partners & funders.

224 SEAD-focused actors\(^1\) profiled in Landscape Analysis

105 Of the SEAD-focused actors were named as partners or funders for other SEAD-focused actors

803 Additional unique orgs. were named by SEAD-focused actors as partners or funders

---

1. Includes all actors profiled in Landscape Analysis for which SEAD is either a primary focus or core to at least some work/initiatives.

Note: 314 total actors reviewed in Landscape Analysis (of which 224 had primary or partial SEAD focus). Of the 224 SEAD-focused actors, 127 listed at least 1 partner or funder and 73 did not list partners or funders on their website. The remaining 24 SEAD-focused actors were philanthropic organizations for which websites were not reviewed for partners/funders based on the methodology.

Source: Landscape analysis stakeholder interviews, BCG Analysis
224 SEAD-focused organizations: Categorized by implementation lever

Implementation Lever

- **School & program design models, curriculum, and other tools**
  - National and regional associations: 34
  - Philanthropic funding: 23

- **Continuous improvement systems, measurement and research**
  - Technical assistance: 22
  - In-service training: 21

- **Local coalition building and high visibility public campaign(s)**
  - (comms., advocacy and engagement):
    - Public funding and advocacy: 13
    - Networks: 11

- **Pre-service training**
  - Social media engagement and educator-led networks
    - (comms., advocacy and engagement): 9
  - Conveners - aligning and convening the field
    - Youth voice and leadership
      - (comms., advocacy and engagement): 4

Source: Landscape analysis stakeholder interviews, BCG Analysis
224 SEAD-focused organizations: Categorized by HQ location

Note: Excludes 15 of 224 SEAD actors for which HQ location was not identified.
Source: Landscape analysis stakeholder interviews, BCG Analysis

Majority of organizations located on east or west coast; (further analysis required to understand extent to which due to selected sample or reflective of true concentration of orgs)

Other HQ locations

<table>
<thead>
<tr>
<th>Location</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>England</td>
<td>1</td>
</tr>
<tr>
<td>Switzerland</td>
<td>1</td>
</tr>
<tr>
<td>North America/ US multi-state</td>
<td>3</td>
</tr>
</tbody>
</table>
Agenda

Approach

Landscape actors

Key findings

Considerations for future analysis
Preliminary findings and potential opportunities from relational mapping

1. Relational mapping identified some anticipated concentrations of actors across the SEAD landscape
   - Philanthropic organizations and funders are very well connected and central to the map
   - Organizations focused on aligning and convening the field also cluster in the center, as well as research institutions given their close association to philanthropy
   - TA providers as well as professional development actors are less central to the network and could be more connected to each other and to the SEAD landscape
   - National and regional associations have a high number of associations but are also on the periphery of the network. This is driven by fewer relationships with funders and with SEAD-focused actors suggesting an opportunity to integrate more with the SEAD community, in particular to broaden geographic scope of work

Overarching map also highlighted 81 SEAD-focused actors that are not connected to the central network map, which may be a function of these organizations not listing partners or funders on their website (although they would still appear connected if other actors listed them as partners/funders) but could also represent certain silos in the field that could be more integrated
   - For example, Dignity in Schools and the National School Climate Center, which both represent important adjacent approaches/movements, are not connected to the central network map

2. There are a subset of actors that are particularly well connected across the field
   - Big Brothers Big Sisters has the most associations of any organization (34) but only 4 connections with other SEAD actors suggesting an opportunity to integrate more with the SEAD community
   - CASEL is unsurprisingly the most well connected organization with a primary focus on SEAD (24 associations)
   - The Gates Foundation is the most well connected funder with 29 total associations, 18 across the profiled set of SEAD-focused actors

3. Review of the organizations named by SEAD actors as partners and funders suggested further opportunities for collaboration
   - The set of partners and funders is fairly fragmented with 725 partners/funders mentioned only one time and accounting for 52% of total mentions
   - 20% of the top 50 named partner/funder orgs are corporate entities. Given active participation from the business community in this work, opportunity exists to further engage this segment across many dimensions including thought-leadership and expertise, partnership and funding opportunities
64% of SEAD-focused actors connected through existing funder and partner relationships

81 of 224 SEAD-focused actors not connected to central map of field actors due to either not listing partners or funders on website OR not listing partners or funders that overlap with central map of actors

Majority of these actors (57%) did not list partners or funders on website

143 of 204 SEAD-focused actors connected in central map of field actors

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.

Source: Landscape analysis stakeholder interviews, BCG Analysis
Concentration of SEAD relationships

Relational network map of all interconnected SEAD actors

Color of box organized by primary lever

- Continuous improvement systems, measurement and research
- Conveners - aligning and convening the field
- In-service training
- Local coalition building & high visibility public campaign(s) (comms, advocacy and engagement)
- National and regional associations
- Networks
- Philanthropic funding
- Pre-service training
- Public funding and advocacy
- School & program design models, curriculum, and other tools
- Social media engagement and educator-led networks (comms, advocacy and engagement)
- Technical assistance
- Youth voice and leadership (comms, advocacy and engagement)

National and regional associations cluster together towards periphery of map - not as well connected to SEAD-focused actors

Philanthropic organizations tend to be well connected / have high number of associations so cluster towards center

Organizations that align and convene the field as well as those involved with research are somewhat clustered together towards the center

TA providers are generally less-well connected, and thus do not appear in the center of the map

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.

Source: Landscape analysis stakeholder interviews, BCG Analysis
Relational map snapshot: Philanthropic funding

Location of Philanthropic organizations in network map

Philanthropic organizations central to network map, representing large influence across broader landscape of SEAD actors

23 total SEAD-focused philanthropic organizations captured in network map
- 20 connected through central network map
- 3 not connected (due to not being listed by another actor as a partner or funder)

Philanthropic organizations central to map (not surprisingly) due to high number of associations with SEAD-focused actors. Most connected funders include -
- Bill and Melinda Gates Foundation (29)
- The Wallace Foundation (20)
- William and Flora Hewlett Foundation (20)
- Carnegie Corporation of New York (19)
- Einhorn Family Charitable Trust (14)

Note: Philanthropic organizations appear in network map only if listed by other organizations as partners or funders. The websites of philanthropic organizations were not reviewed for listed partners or funders as more detailed information was captured as part of separate funder analysis; total associations equal to number in right hand corner of actor minus 1. Source: Landscape analysis stakeholder interviews, BCG Analysis
Relational map snapshot: Additional central actors include those focused on research and convening

Location of research-oriented and convening organizations in network map

- Conveners - aligning and convening the field
- Continuous improvement systems, measurement and research

Research-oriented actors and conveners, pulled towards center through funding relationships

22 total SEAD-focused actors related to continuous improvement systems and research captured in network map
- 11 connected through central network map
- 11 not connected (due to either no listed partners or funders or no overlap with other actors in network map)

These organizations are pulled centrally due to close connections with specific philanthropic organizations (vs. many associations across SEAD-focused actors)
- For example, MeasuringSEL has 10 connections to SEAD-focused actors, 6 of which are to funders

4 SEAD-focused actors related to aligning and convening the field, with the National Commission, CASEL and the National Public Education Support Fund all clustering towards center

Note: Total associations equal to number in right hand corner of actor minus 1
Source: Landscape analysis stakeholder interviews, BCG Analysis
Concentration of SEAD relationships

Relational map snapshot: TA Providers

Location of TA providers in network map

Technical assistance

Communities in Schools and Search Institute

Every Hour Counts

Primarily located around periphery, suggesting opportunity for great collaboration with SEAD actors

21 total SEAD-focused TA providers captured in network map
- 14 connected through central network map
- 7 not connected (due to either no listed partners or funders or no overlap with other actors in network map)

SEAD-focused TA providers tend to cluster throughout periphery of map, suggesting more limited connections across SEAD actors; TA providers with the greatest associations include -
- Communities in Schools (24)
- EducationCounsel (22)
- Search Institute (20)
- Every Hour Counts (19)

Small number of TA providers connected to other TA providers, e.g. Every Hour Counts connected to both Partnership for Children and Youth and ExpandED Schools
- May suggest opportunity for greater collaboration (but likely due to TA providers not listing other TA providers on website)

Note: Total associations equal to number in right hand corner of actor minus 1
Source: Landscape analysis stakeholder interviews, BCG Analysis
Relational map snapshot: Other peripheral actors in network map

Location of national and regional associations and training actors in network map

Primarily located around periphery, suggesting opportunity for great collaboration with SEAD actors

22 total SEAD-focused pre-service or in-service training actors captured in network map
- 12 connected through central network map
- 10 not connected (due to either no listed partners or funders or no overlap with other actors in network map)

The most well-connected of these actors include San Jose University Collaborative for Reaching and Teaching the Whole Child (22) and Relay GSE (21)

23 SEAD-focused national and regional associations captured in network map
- 16 connected through network map
- 7 not connected (due to either no listed partners or funders or no overlap with other actors in network map)

These organizations cluster tightly together on periphery of map suggesting they are well connected to each other but less so with broader pool of SEAD-focused actors captured

Source: Landscape analysis stakeholder interviews, BCG Analysis
Most well connected SEAD actors

**Primarily focused on SEAD**

Organizations with most connections reflect diverse group with national breadth, 30% are primarily SEAD focused

**30% of most connected actors are primarily focused on SEAD**

![Bar chart showing connections](chart)

**Color of name organized by primary lever**

- Blue: Continuous improvement systems, measurement and research
- Yellow: Conveners - aligning and convening the field
- Red: In-service training
- Green: Local coalition building & high visibility public campaign(s) (comms, advocacy and engagement)
- Orange: National and regional associations
- Grey: Networks
- Pink: Philanthropic funding
- Purple: Pre-service training
- Pink: Public funding and advocacy
- Turquoise: School & program design models, curriculum, and other tools
- Blue: Social media engagement and educator-led networks (comms, advocacy and engagement)
- Grey: Technical assistance
- Brown: Youth voice and leadership (comms, advocacy and engagement)

Note: Connections counts number of funders and partners named by the SEAD actor on website as well as when they were named by other actors. Total associations reported in Toughgraph includes actual field actor, therefore # of connections is equal to Touchgraph number minus 1 (as reported here).

Source: Landscape analysis stakeholder interviews, BCG Analysis
Total associations based on entire map of actors (not just SEAD-focused)

Big Brothers Big Sisters with most total associations (34) but only ~4 to SEAD-focused actors

Bill & Melinda Gates Foundation with fewer total associations (29) but greater number of connections to SEAD-focused actors

Note: Total associations equal to number in top right hand corner minus 1 (number shown includes SEAD-focused actor)

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that connected them to other organizations in the SEAD-focused map. There are additional organizations in the database that do not appear in this view.

Source: Landscape analysis stakeholder interviews, BCG Analysis
While certain partners and funders mentioned multiple times by SEAD-focused actors, majority of listed partner or funders appear only once.

- Total number of mentions by SEAD-focused actors as partners or funders:
  - Named by 4+ SEAD actors: 368
  - Named by 3 SEAD actors: 105
  - Named by 2 SEAD actors: 196
  - Named by 1 SEAD actor: 725

- Unique named partners & funders:
  - Named by 4+ SEAD actors: 50
  - Named by 3 SEAD actors: 35
  - Named by 2 SEAD actors: 98
  - Named by 1 SEAD actor: 725

- ~85 partners/funder orgs were mentioned 473 times (34% of total) by SEAD orgs.

Long fragmented tail as ~52% of total named partners/funders are mentioned only once in review of SEAD relationships.

1. Across 224 SEAD-focused actors in Landscape Analysis
Source: Landscape analysis stakeholder interviews, BCG analysis
Top ~50 partner/funder orgs named by SEAD actors include concentration of major foundations as well as multiple corporates

- Partners & Funders named by 4+ SEAD actors

10 corporate partners/funders in top 50 present potential opportunity to engage more directly as part of funder group going forward

Partners / funders that are mentioned most frequently are highly concentrated with philanthropic organizations

Concentrated partner & funder universe
Agenda

Approach
Landscape actors
Key findings

**Considerations for future analysis**
Next steps for Landscape Analysis

- **Hand over to National Commission staff for near-term ownership**
  - Distribute through website and as appropriate through partnership channels

- **Determine long-term owner of Landscape Analysis**
  - Likely successor coalition or member(s) of funders collaborative

- **Finalize process for updating over time including any additional information to capture as part of Landscape Analysis** 
  
  *(See following page for more details)*
  - Update annually through comprehensive refresh process
  - Consider automating components of process given labor-intensity
  - Several potential ways to extend analysis, e.g. greater breadth of actors captured, additional data fields
Four main areas to refine and enhance Landscape Analysis going forward

Expand the universe of profiled actors
- Include broader set of stakeholders including more from adjacent movements
- Extend reach to more consistently capture regional and local actors

Refine the analysis to ensure greater accuracy
- Capture information on partners and funders for organizations that do not publicly name those relationships on their website
- Refine categorization by implementation levers based on further socialization with stakeholder community

Collect and analyze additional data fields. For example:
- Board member composition including demographic information
- Associated frames used by organization
- Years of operation
- Student/youth populations served including age range, demographics, etc.
- Organizational size and scope, e.g. budget, number of school districts served

Enhance approach for collecting data
- Create more defined process for collecting data systematically from universe of SEAD actors (e.g., survey)
- Consider automated methods for capturing data (e.g., webscraping)
Appendix
Relational network map of all SEAD-focused actors from Landscape Analysis

Each SEAD-focused organization from Landscape Analysis database appears as a box on the map.

The total number of associations listed for the organization is indicated in the upper right corner; associations not part of Landscape Analysis database not shown but included in total partnerships. Note this number includes the actor listed so true associations to other partners or funders is equal to N-1.

Several actors (81/224) not shown because not connected through a particular funder or partner within map of actors.

Color of box organized by primary lever:
- Continuous improvement systems, measurement and frameworks
- Conveners - aligning and convening the field
- In-service training
- Local coalition building and high visibility public campaign(s) - comms, advocacy and engagement
- National and regional associations
- Networks
- Philanthropic funding
- Pre-service training
- Public funding and advocacy
- School & program design models, curriculum, and other tools
- Social media engagement and educator-led networks - comms, advocacy and engagement
- Technical assistance
- Youth voice and leadership - communications, advocacy and engagement

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.

Source: Landscape analysis stakeholder interviews, BCG Analysis
Each organization can be viewed in isolation in the mapping tool

Solid line connection represents a partner relationship

Dotted line connection represents a funding relationship

Color of box organized by primary lever

- Continuous improvement systems, measurement and frameworks
- Conveners - aligning and convening the field
- In-service training
- Local coalition building and high visibility public campaign(s) - comms, advocacy and engagement
- National and regional associations
- Networks
- Philanthropic funding
- Pre-service training
- Public funding and advocacy
- School & program design models, curriculum, and other tools
- Social media engagement and educator-led networks - comms, advocacy and engagement
- Technical assistance
- Youth voice and leadership - communications, advocacy and engagement

Number represents total number of associations including existing field actor, e.g. 2 (only associations with SEAD-focused actors shown in map)

Note: In order for an organization to appear in this view, they needed to show up in our original list of SEAD-focused actors (224) and have at least one association that connected them to other organizations in the map. There are additional organizations in the database that do not appear in this view.

Source: Landscape analysis stakeholder interviews, BCG Analysis
Excel database of actors includes variety of information on each organization, and is the input to TouchGraph Navigator to create the relational map.
Landscape Analysis framed around ~14 implementation levers identified through Commission's work and stakeholder conversations (I/II)

1. Encourage creation of new school models and enhance marketplace of integrated social, emotional and academic-related products and services, e.g., curriculum, technology, etc. to drive high quality implementation

2. Create and roll out a broadened set of systems and tools for measurement of social, emotional and academic learning environments

3. Expand supply of high quality technical assistance to districts and the out-of-school time sector, building implementation capacity

4. Build capacity and buy-in of place-based networks and equip with resources to support local adaptation and implementation

5. Redesign educator preparation programs to balance knowledge of standards with an understanding of youth development and transform vision for school learning environments

6. Focus leadership and educator development providers' programs more explicitly on developing adult capacity in social, emotional and academic domains
### Implementation levers

<table>
<thead>
<tr>
<th>Public funding</th>
<th>Philanthropic funding</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>vii</strong> Promote increased and more flexible federal and state resources to support integrated social, emotional and academic development in a way that ameliorates existing disparities</td>
<td></td>
</tr>
<tr>
<td><strong>viii</strong> Coalesce and integrate catalytic resources around highest priority implementation opportunities and questions across practice, policy and research</td>
<td></td>
</tr>
</tbody>
</table>

### Communications, advocacy and engagement

| ix | Mobilize youth voice and leadership to actively drive national and local implementation agenda |
| x  | Grow familiarity, alignment and commitment of families, parents, caregivers and grass-roots organizations in local communities through balance of local coalition building and high visibility public campaign(s) with clear, consistent messaging |
| xi | Engage educators to spread best practices and awareness about social, emotional and academic development through social media engagement and educator-led networks |
| xii| Engage and advocate to local, state and federal policy makers to enhance and create supportive conditions for implementation |

### Aligning and convening the field

| xiii| Ensure social, emotional and academic development is prioritized on agenda of major national and regional associations within the education and out-of-school time (OST) sectors |
| xiv| Develop a more aligned, diverse and inclusive field by encouraging ongoing collaboration and continuous improvement |
Touchgraph Navigator overview
Touchgraph Navigator

- Touchgraph Navigator is a tool used to visualize networks. It is typically used for mapping projects to display different views of the networks from an organizational database.

- The tool is capable of displaying combinations of individuals, organization, and publications, as well as the connections between these types of network nodes.

- In addition to various combinations of network node types, the tool can also show varying degrees of the network - from the full, high level shape of the network, to detailed, drill down networks of single individuals and organizations.
Types of network nodes
- Organizations
- Individuals
- Published articles

Types of connections
- Co-membership—organizations connected by common individuals between the different organizations
- Co-authorship—individuals connected by co-authoring a paper together. Results in the organizations the authors belong to being linked as well
- Direct relationship—organizations or individuals connected by a direct (forced) link

Level of detail
- Capable of showing high level view of the network with up to 10K individuals and organizations (general shape, overall view of connectivity)
- Ability to drill down to a single individual and organization, click on a single link or node and view underlying data
Touchgraph Navigator
Introduction to major processes

Loading dataset
After installing and launching Touchgraph, navigate to File -> Open Wizard and locate the Excel data file you wish to use.
Touchgraph Navigator
The data panel

The left hand side of the tool has a data table organized into two tabs with a drop down to navigate further:

- **Entities**—Includes information about all defined entities and their attributes
  - Organizations

- **Relations**—Includes information about all defined relationships between entities and their attributes
  - Organization to funder relationship
  - Organization to partner relationship
  - Organization’s primary lever
  - Organization’s level of focus on social, emotional, and academic development

The window in the upper left shows more detailed data for any node that is selected.

The different attributes chosen when creating the original settings file determines what information is displayed in the different columns.

Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.
Touchgraph Navigator
The user settings panel: filter inclusion and attribute filter

Filter > Inclusion tab lets you determine what is displayed in the network visual

Filter > Attribute Filters lets you set criteria for inclusion in the network

Select what entity or relation you would like to filter on (Example: number of associations)

Check to include different types of connections in the network

Set condition to exclude or include based on attribute

Select the filter thresholds

Select what attribute you would like to filter on (Example: at least one partner or funder to show in network map)

Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.
Touchgraph Navigator
The user settings panel: node appearance

Node Colors, Size, Labels and Tags can all be modified under the Node Appearance

Select the Node Type and use the drop down to select color options

Node labels (content and appearance) can be changed under Node > Label/Image

Select what attribute the node size will be correlated to

Select whether to display a halo use the slider to scale size

Note: Thumbnail slides do not represent actual data. All data shown is purely illustrative.
Touchgraph Navigator
The user settings panel: edge appearance

Edge Colors, Width, and Tags can all be modified under the Edge Appearance.

Select the EdgeType and use the drop down to select color options.

Select what attribute the edge width will be correlated to.

Select whether to display the edge and use the slider to scale width.
Touchgraph Navigator
The user settings panel: top bar

Amount of network nodes to show
- All: all nodes that meet requirements in filter settings
- Single: single selection of nodes
- Degrees of separation: how many steps to take along the network from the starting node(s)

Coloring tool to manually color a selection of nodes
(Example: an entire category of nodes that were selected in the left data panel)

Zoom and spacing controls to manipulate the display of the network

Play/Pause toggle—press play to let the program optimize the display of the network. When want to manually manipulate the network with the hand tool, first pause the display. Pausing also allows for quicker operation without bogging down computer resources.